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OPERATING SYSTEM 

1.0 INTRODUCTION 
System software is a series of programs written to simplify the interface 

between the programmer and the computer hardware. System software is generally 
composed of an operating system (OS), language translators, utilities, data 
management and data communication systems. The OS which functions as an office 
manager for the computer system. 

Overall purpose of the OS is to control the activities of the computer system. 
It serves as the traffic cop, directing and managing computer events. In addition, the 
OS provides a useful interface that allows the user to concentrate on what he wants 
to accomplish, rather than on the details of how the computer internally carries it out. 

Three of the major functions of an OS are overall master control, resource 
management, and monitoring activities. The tremendous demand for computing power, 
the need for increased reliability, and the decreasing price of hardware have led to OS 
designed for use with computer systems that have multiple processors. 

While there hasn't been any official committee that has specified industry 
parameters, several de facto standards for microcomputer OS have developed. A de-
facto standard is one that vendors informally accept, generally because it has come 
to dominate a market segment of the business. For the PCs, it is the DOS operating 
system. In some computers, OS is being implemented in firmware, as permanently 
coded instructions within a ROM. Other popular OS are Windows and OS/2. 

A critical point to understand is that application programs or software packages 
such as payroll, word processing, and spreadsheet are designed for use with a 
specific OS. In turn, most OS are designed for use with a particular microprocessor. 
The general rule is that application software is not portable. That is, it cannot be used 
with just any computer system. 

2.0 MS DOS 
MS-DOS or the Micro Soft Disk Operating System consists of a group of 

programs which has the following functions : 

to monitor commands given by the user to the computer, 
to load and execute programs specified by the user, 
to manage the devices attached to the computer, 
to manage the files of data and programs that the computer will work with. 

MS-DOS allows the user to enter the commands in upper case letters, lower 
case letters or a combination of both. All the DOS commands are terminated by 
[Enter] key. The important commands of DOS are described below: 

2.1 ATTRIB Command 
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This command allows to set the read attributes of a file to read-only or to 
display the attributes of a file. The syntax is : 

[path]ATTRIB [+/-A] [path]filename.ext 
where 

[path] before ATTRIB specifies the path of the ATTRIB command file. 
[+/-R] is used to set the read attributes of the specified file and 
filename.ext specifies the file you want to mark as read-only. 

2.2 BACKUP Command 
This command backs up one or more files from a disk to another disk. The 

drive specifiers of the disks must be different. The syntax is : 

[path]BACKUP d:[path]filename d: USWMWD:mm-dd-yy] 

where 
[path] before BACKUP specifies the path of the BACKUP command file. 
d:[pathIfilename specifies the filenames to be backed up.(Source) 
d: specifies the drive that will contain the backed up files.(Destination) 
/S is used to backup all the files in all the subdirectories in addition to the 
files in the specified directory. 
/M is used to backup files that have been modified since the last backup. 
/D is used to back up files that have ben modified on or after the specified 
date. The format of the date spe4cified will be mm-dd-yy. 

2.3 CD Command 
This command changes the working directory. The syntax is : 

CD <directory_name> 
e.g. 

CD \IRCC 

will set working directory as \IRCC. 

2.4 CHKDSK Command 
It shows the space available on disk or floppy. The syntax is: 

CHKDSK 

2.5 CLS Command 
This command clears the screen. 

2.6 COPY Command 
This command copies the contents of one file to the other file. The syntax is: 

COPY <file_one> <file_two) 
e.g. 

COPY ABC.EXT XYZ.EXT 
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As a result of the above command there will be two files in the directory with 
same contents but with different names ABC.EXT and XYZ.EXT. 

2.7 DATE Command 
This command is used to change the date known to the DOS. The syntax is: 

DATE [mm-dd-yy] 

where 
mm-dd-yy specifies the date in month-day-year format. 

2.8 DEL or ERASE Command 
It deletes selected files. The syntax is: 

DEL <filename.ext> 

ERASE <filename.ext> 
e.g. 

DEL RAJEN.BAK 

will delete the file RAJEN.BAK from current directory. 

2.9 DIR Command 
It gives the information about the file like, file name, extension, size of the file 

in bytes and date and time the file was last edited. e.g. 

DIR 
will display all the file in current directory. 
DIR/P 
will display directory, pausing after every screenful to enable the user to 

examine the list. 

2.10 MD Command 
This command is used for creating a directory or subdirectory. The syntax is: 

MD <Directory name> 
e.g. 

MD IRCC 

will create a sub directory IRCC in the current directory. 

2.11 PATH Command 
This command searches specified directories for commands or batch files that 

were not found by a search of the current directory. The syntax is: 

PATH [pathl;path2  

A list of drives and path names, seperated by semicolons can be specified. 
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2.12 PRINT Command 
This command prints a file. The syntax is : 

PRINT <filename > 

2.13 PROMPT Command 
This command is used to set a new DOS prompt. The syntax is : 

PROMPT [prompt text] 

2.14 RD Command 
This command is used for deleting a directory or sub directory. The syntax is: 

RD <directory name> 

For deleting a directory, it should not contain any file i.e. the directory should 
be empty. 

2.15 RENAME Command 
It changes the name of selected file. The syntax is: 

RENAME <oldfile_name> <newfile_name> 
e.g. 

RENAME ABCD.FOR KKK.FOR 

will rename the file ABCD.FOR to KKK.FOR. 

2.16 RESTORE Command 
This command restores one or more backup files from a disk to another disk. 

The syntax is : 

[path]RESTORE d:[/S] 
where 

[path] is the path of the RESTORE command file. 
d: is the drive that contains the backup files. 
/S is used to restore all files in all the subdirectories in addition to the files in 
the specifies directory 

2.17 SYS Command 
This command transfers the operating system files from the first drive specified 

to the second drive specified. Ths syntax is : 

[path]SYS d: 
where 

[path] before SYS specifies the path of the SYS command file and 
[d:] specifies the disk drive where the operating system files are to be 

transfered 
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2.18 TIME Command 
Whenever any file is created or modified, the time of creation/modification of 

that file is recorded in the system. This command permits to change the time known 
to the system. The syntax is : 

TIME [hh:mm:ss] 
Where, 

hh specifies the hours 
mm specifies the minutes and 
ss specifies the seconds 

2.19 TREE Command 
This command displays all of the directory paths found on the specified drive., 

and optionally lists the files in each subdirectory. The syntax is : 

[pathITREE d:][/F] 
where, 

[path] before TREE specifies the path of the tree command file 
[d:] specifies the drive whose directory paths are to be displayed and 
[/F] is optionally used to display the names of the files inthe subdirectories. 

2.20 TYPE Command 
It displays the contents of an ASCII file on the screen. The syntax is : 

TYPE <filename.ext> 
e.g. 

TYPE RAJEN.DAT 

will display the contents of file RAJAN.DAT on screen. 

2.21 Changing the Drive 
To change the drive type the drive name followed by colon( : ) sign (without any 

blank). e.g. 

A: 

The default drive will be A: now. 

2.22 Halting the rushing text 
When a program puts out many lines of data in rapid succession the user need 

a way to stop the flow of text so that it can be read before it rolls off the screen. Press 
[Ctrl] and [S] keys simultaneously for hafting the flow of text. Press any key to restart 
the flow of text. 

2.23 Copying file from one floppy to other floppy 
When system contains only one floppy drive, floppy swapping is necessary, e.g. 

if a file is to be copied from 'X' floppy to 'Y' floppy, with floppy 'X" is in drive A, type 
the following : 
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COPY A:<filename> B: 

As a result the file <filename> will be copied from floppy X to floppy Y. 

For copying the whole floppy, DISKCOPY command is used which also formats 
the target floppy. The syntax is: 

DISKCOPY A: B: 

It will format the target floppy and copy all the files from A drive to B drive. 

2.24 Copying file from floppy to directory 
Insert floppy in drive A and type 

COPY A:<filename> c:<directory name> 
e.g. 

COPY A:*.* c: IRCC 

will copy all the files of floppy to IRCC directory. 

2.25 Shut Down Squence 
This sequence to shudown the system is : 

First remove the floppy from floppy drive, if any . 
Switch off the printer. 
Switch off the C P U. 
Switch off the monitor. 

3.0 MS WINDOW 3.1 

3.1 Introduction 
Windows is a GUI (Graphical User Interface) combined with support of 

standardized methods. Instead of being a full operating system, Microsoft had 

originally developed Windows as an add-on over MS-DOS. However, the Windows 

95 has been developed as a full fledged OS. 

3.1.1 What is WINDOWS?  

Windows is an operating environment. It can be called User interface 

methodology where user need not concern himself with how windows work, because 

the goal of windows application developes is to use the windows environment with 

more visible continuity. 

3.1.2 Why Use WINDOWS? 
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Some reasons why windows is becoming popular around the world. are : 

It is an easy-to-use. consistent GUI for virtually all programs. 

It is capable of multitasking (running several programs simultaneously). 

Graphics programs and character based programs can be run concurrently. 

Program Manager can be used to switch easily between multiple program. 

With windows user can communicate and exchange data between programs 

without transferring or copying files. 

As file and disk-mangement are simple and readily available, user don't have 

to close and open programs or use DOS commands to do standard file and 

disk- maintenance chores. 

Windows can run applications that offer high quality output. 

Many programs are included with windows, such as word processor and a 

drawing program. 

3.1.3 Requirement  to Run WINDOWS 
Windows runs on two operating modes depending upon hardware configuration. 

(i) For PC 386 enhanced mode: 

A personal computer with a 386 processor or higher having : 

640 K conventional memory 

1024 K extended memory 

8MB of free disk space 10 MB recommended 

One floppy disk drive 

(ii) For Standard mode: 

A personal computer with a 286 processor or higher or 386 that has less 

than 2MB of free Memory having: 

640 K of conventional memory 

256 K of extended memory 

6 MB of free disk space 
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one floppy disk drive 

A display adapter that is supported by windows 

A printer that is supported by windows 

A mouse that is supported by windows 

Modem if terminal is to be used for windows application. 

3_1.4 Running Programs Simultaneously 
Depending on available hardware, doing several tasks simultaneously is made 

easy through windows. For example when the user switches from painting program 

to word processor he has to exit the painting program go to MS-DOS and then start 

the word processor. Leaving programs can be slow starting programs usually is even 

slower. With windows switching between programs is less than a second. 

3.1.5 Communication Among_WINDOWS Programs 
Two major methods for passing information are clipboard and OLE (Object 

Linking and Embedding). Most of interprogram communication is done through the 

clipboard. 

Clipboard 

Clipboard is a buffer or holding area in system memory that contains one piece 

of data at any one time. Read and write is done through standard commands. 

OLE (Object Linking & Embedding) 

OLE is a method for passing data directly between programs without having to 

use the clipboard. It can be though of a telephone network on which one program can 

dial another program and pass on certain types of information. 

3.1.6 Starting and Leaving Windows: 

Starting windows: 

Starting windows with WIN command from MS-DOS prompt 

C>WIN 

It automatically runs Program Manager 

Running programs as you start windows: 
If user knows the name of program on MS-DOS command line, WINDOW 

starts that program rather than Program Manager 
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C: >WIN \WORD5\WORD 

It starts the word program as it is in WORD5 directory. 

(iii) Leaving Windows: 

As windows is an operating environment, not a single program it requires a 

separate operating system (DOS). 

When user exits from other window programs it returns to program Manager. 

When program manager is in front window, give the Exit Command in the file 

menu or press Alt-F4. 

When user closes Program Manager he is presented with a dialog box Press 

OK to leave windows to resume working in windows press Cancel or Esc key. 

3.1.7 Menus and Commands:  

The most common way to tell windows what user wants to do is by choosing 

a command from a menu. Every window program has atleast one menu and most 

have four or more. The menu bar is at the top of the program window. the Program 

Manager menu bar has the following pull down menus : 

File 

Options 

Window 

Help 

Elipses and Check Marks 

In some commands, an elipses _J follows the command name. In file 

menu the commands such as New, Move, Copy etc. have elipses but others like Open 
and Delete do not. 

An elipses indicates that the command does not execute directly. Instead the 

command issued displays a dialog box from which you can make additional choices 

before the command executes. 

Sometimes commands have a check mark to their left. The check mark 

indicates that the particular maked command is currently active or selected. The check 
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mark is absent when the command is unselected or when it isinactive. Check marks 

are ON/OFF indicators and sometimes called toggles. 

3.2 Main Window Manager Programs: 

3.2.1 Program Manager 

Program Manager organises user programs into groups. 

The central program from which user can run other programs is the window 

Program Manager. 

User see this program running when he first starts windows and again when he 

is about to leave windows. 

Its features is its flexibility. 

When window starts it looks like as in Fig.1 

r  P•cgram-itern icons represent app ,cations you can rur. 

The screen background  
 Each of these areas 

is known as the desktop. is a window. 

Fig.1 PROGRAM MANAGER 
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User can easily change the ways programs appear in Program Manager, 

rearrange the programs, add new ones, remove old ones and so on. 

User can configure how programs should run whether they should run at the 

start and what documents to open when program starts. 

Windows on installation comes with about five icons which are called program 

groups as they hold related programs. They are as follows : 

c Start-up o Main o Accessories 

c Application o Games 

Menus in Program Manager 

The four menus of Program Manager are File, Options, Windows and Help 

(i) File 

New  

Open Enter 

Move F7 

Copy F8 
Delete  Del 

Properties  Alt + Enter 
Run  

Exit Windows  

Fig. 2. File Menu 

Table - 1 
Command Function 
New Creates new program groups and icons. 
Open Open the application icon that has a high-lighted text. 
Move Moves icon from one group to another. 
Copy Makes a copy of a highlighted icon from one group in 

another desired group. 
Delete Removes the selected icon or group permanently. 
Run Starts an application or opens a document. 
Exit Windows Command to leave windows. 
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(ii) Options 

Auto Arrange 

Minimize on Use 

Save Settings on Exit 

Fig.3 . Preferences chosen from options menu. 

Command 

Auto Arrange 

Minimize on Use 

Save settings on Exit 

(iii) Window 

Cascade 

Tile 

Arrange Icons 

Table - 2 

Function 

Arranges icons Automatically 

Causes the last program used to change to an icon. 

Decides whether changes to window environment will 
be saved. 

Shift + F5 

Shift + F4 

Main O Startup o Applications 
Games o Accessories 

Fig.4. The Window menu with main group chosen. 

Table - 3 

Command 

Cascade 

Tile 

Arrange Icons 

Available Groups 

Function 

Displays the window opened below and to the right 
of each other. 

Divides the screen equally between the opened 
windows. 

Enables the space icons manually. 

List of the program groups available for use in 
in windows. 
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(1V) Help 

Contents 

Search for Help on _ _ _ 

How to use Help 

Window tutorial 

About Program Manager_ _ _ 

Fig.5. Help Menu of Program Manager. 

Table - 4 

Command Function 
Contents Displays a table of topics covered in Help 

Search for Help on Shows a detailed alphabetical list of topics in 

Help from which user can choose. 

How to use Help Provides tips and techniques to use Help. 

Window tutorials Lessons to know window basics. 

About program Information about users copy of Program 
Manager Manager, its operating mode memory capacity and 

available system resources. 

3.2.2 File Manager 

File manager can be started from Program Manager by double clicking its 

icon in the Main group window. 

File manager provides a graphical representation of files and directories and 

help the user to organize and simplify file maintenance. 

The directory window is divided by the split bar. The left side of the window 

displays the structure of the current drive, or the directory tree. The right 

side of the window displays a list of files in the selected directory as seen in 
Fig.6. 

User can use the drive icons on the drive bar to choose what drive is displayed 
in a directory window. 
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o Status bar displays information about the current drive and directory and 

other information that helps explain the task user is performing with File 

Manager. 

The Menu bar contains menus listing File Manager Commands. 

Tasks performed by File Manager 
View the contents of directories. 

- Move, copy and delete files and directories. 

Change to other disk drives, including network drives. 

- Format and maintain disks. 

- Print Documents. 

Start Application. 

Rename and delete files. 
Change the kind and amount of information displayed about each file. 

- Create directories and subdirectories. 

Searching for files. 

3.2.3 Print Manager 
Print Manager is an application included with Windows that user can use to 

manage documents sent to a printer and can install and confiure printers, as shown 

in Fig.7. 

Whenever user print from a window based application, the application creates 

a print file and sends it to Print Manager. Print Manager works in background, 

sending users documents to the printer while he can continue working. 

User can check the status of the document at any time and change its status 

until it starts printing. 

As user sends documents to Print Manager, a print queue forms. The point 

queue displays the following printer information : 

The name of the printer. 
The port printer is connected to and, if it is a network printer, the network path. 

The current status of the printer (such as native or idle). 

Beneath the printer information, the print queue displays the following document 
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information. 

The title of the document. 
The document's position in the queue, or a printer icon if the document is 

printing. 
The size of the document in kilobytes (if the Print file size command has a 

check mark next to it). 

The time and date user sent the document to Print Manager. 

If a document is currently printing, the amount (as a percentage) of the 

document printed so far. 

To Pause printing 

In print Manager window, select the name of the printer user want to pause. 

Choose the Pause button, Or press ALT + P. 

To Resume printing 

In print Manager window, select the document or the name of the printer you want 

to resume printing. 

Choose the Resume button. Or press ALT + R. 

To Cancel printing 

In print manager, select the document user wants to cancel. 

Choose the Delete button. Or press ALT + D. A dialog box appears, prompting to 

confirm the deletion. 

3.3 Other Programs That Come with Windows 

Write, a word processor that can prepare letters reports and articles. 

Paintbrush,  a painting program that can create colour or black & white drawings. 

Calendar,  an appointment calendar that helps you organize user time and alerts 

when important events are planned. 

Cardfile, an organizational program user can use to keep and search for 

information. 

Terminal, a communications program for connecting your PC to other computers 

through a modem. 

Calculator,  a desk calculator that can replace that old pocket model. 

3.4 Keyboard Shortcuts 
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User can use keyboard shortcuts to do common Window tasks. 

3.41 Using Help 

To Press 

Start Help Fl 

Move among jumps in a topic TAB or SHIFT + TAB 

Display all the jumps in a topic 

or cancel the selection of a jump CTRL + TAB 

Copy a Help screen or annotation ALT + PRINT SCREEN 

into the clipboard 

Quit Help ALT + F4 

3.4.2 Switching between Applications 

To switch Do this 

Between applications Press and hold down ALT or SHIFT + 

ALT and repeatedly press TAB 

To the next application Press ALT + ESC 

To the previous application Press SHIFT + ALT + ESC 

To task list Press CTRL + ESC 

An MS-DOS based application from Press ALT + ENTER 

a full screen to a window and back 

3.4.3 Using Menus 

To Press 

Activate the menu bar ALT or F10 

Select a menu ALT + the underlined character in the 

menu name 

Choose a menu command An arrow key, ENTER or the under- 

lined character in the command name. 

Open the control menu for an ALT + SPACE BAR 

application window 

Open the Control menu for a ALT + HYPHEN 

document window and a group 

window. 

3.4.4 Moving Around 

To move Press 
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Between menu commands, 

characters in a text box, or items in a list. 

To next or previous dialog box item 

To a dialog box Item 

Right or Left one word in a text box 

To beginning or end of a line, 

list, or screen 

Up or Down one screen 

3.4.5 Selecting Items 

In a Document Window 

To select 

One line of text up or down 

Text to the beginning or end of a 

SHIFT document 

Ina Document Window, Text Box, or List 

To Select 

Text to the beginning or end of a line 

The next or previous word 

One letter at a time to left or right 

In a Dialgg Box 

To Select 

Select nonconsecutive items in a list 

Select a list item or check box 

Select all items in a list 

Cancel all selections in a list except 

the current one 

3.4.6 Editing Text 

In a Text Box or  Window 
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An arrow key 

TAB or SHIFT + TAB 

ALT + the character underlined 

in the item name. 

CTRL + an ARROW key. 

HOME or END 

PAGE UP or PAGE DOWN 

Press 

SHIFT + UP ARROW or 

SHIFT +DOWN ARROW 

SHIFT + CTRL + HOME or 

+ CTRL + END 

Press 

SHIFT+HOME or SHIFT+END 

SHIFT + CTRL + RIGHT Arrow 

or SHIFT + CTRL + LEFT Arrow 

SHIFT + LEFT Arrow or 

SHIFT + RIGHT Arrow 

Press 

SHIFT + F8, Use arrow key to 

move item to be selected, press 

SPACEBAR to select item,press 

SHIFT + F8 again. 

SPACEBAR 

CTRL + SLASH (/) 

CTRL + BACKSLASH (\) 



Press 

BACKSPACE or DEL 
To 

Delete the character to the left or 

right or delete selected text. 

Copy selected text into the clipboard 

Move selected text into the clipboard 

Paste text from the clipboard 

Undo the last editing action 

3.4.7 Coping onto the Clipboard 
To 

Copy an image of the entire screen 

onto the clipboard. 

Copy an image of the active window 

on to the clipboard. 

CTRL+ C or CTRL + INS 

CTRL + X or SHIFT + DEL 

CTRL + V or SHIFT + INS 

CTRL + Z or ALT+BACKSPACE 

Do this 

Press PRINT SCREEN 

Press ALT + PRINT SCREEN 

3.4.8 Quitting an Application & Closing a Window 

To Press 

Quit an application ALT + F4 

Close the active document window CTRL + F4 

or group window. 

3.4.9 Program Manager 
To 

Move between groups 

Move between items in a group window 

Start the selected application or restore 

the selected group icon. 

File the group windows 

Cascade the group windows 

Close an active group window 

3.4.10 File Manager 
To 

Move among the left and right side of 

the directory window and the drive bar. 

Change the drive displayed in the  

Press 

CTRL + F6 or CTRL + TAB 

An arrow key 

ENTER 

SHIFT + F4 

SHIFT + F5 

CTRL + F4 

Do this 

Press TAB or F6 

Press CTRL + the letter 

representing directory window. 
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Display or hide a selected directory's 

subdirectories, start a selected appli-

cation, or open a selected file. 

Open a new window, display only the 

contents of the selected directory. 

Select the next file or directory whose 

name begins with a certain character. 

Move the selected file or directory. 

Copy the selected file or directory. 

Update the information displayed. 

Display the properties of the selected 

file or directory. 

3.4.11 Print Manager 

To 

Move between queues and between 

documents in each queue. 

Move the selected document up or 

down in a queue. 

Update the information displayed 

3.4.12 Write 

To 

Undo the last typing or editing action 

Insert a manual page break 

Insert an invisible hyphen  

Press ENTER 

Press SHIFT + ENTER 

Press the first character or file 

or directory name. Press F7. 

Press F8 

Press F5 

Press ALT + ENTER 

Press 
Up Arrow or Down Arrow 

CTRL + UP ARROW or 

CTRL + DOWN ARROW 

Press F5 

Do this 

Press C+Zor ALT+BACKSPACE 

Press CTRL + ENTER 

Press CTRL + SHIFT + HYPHEN 

(only to be used when a word is wrapped). 

Switch between the document and Press ALT + F6 

Find or Replace dialog box or between 

the Header and Footer window and the 

Page Header or Page Footer dialog box. 

4.0 WINDOW-95 

4.1 Introduction 

Window 95 is an operating system it bypasses DOS and runs completely in 

protected mode. It can however stop briefly in real mode at start up to process the 
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now-optional CONFIG.SYS and AUTOExEe.BAT, to load TSRs and old device drivers. 

With Window 95 INI files will be a history, cruicial configuration details like user 

preferences, hardware settings and security are stored in the Registry - a database 

user can distribute across a Window 95 network. The OS also expands and contracts 

its cache buffer space to match available memory - thus ending swap-file tinkering and 

cache memory problems. Window 95 is 32 bit but microsoft has left some 16-bit code 

in so that it can run on 4MB systems. 

4.1.1 What's on  Window 95 screen  
Depending upon how computer is set up, various items appear on desktop. 

Whenever Window is started. 

- My Computer 
By double clicking this icon computer contents can be seen and files can be 

managed. 

- Network Neighbourhood 
By Double clicking this icon user can see available resources on the network, 

if the computer is connected to any of the network. 

- Recycle Bin 
The Recycle Bin is a temporary storage place for deleted files. User can use 

it to retrieve files deleted in error. 

- Start button 
User can click start button on the task bar to start a program, open a document, 

change system settings, get Help, find items on Computer. 

4.1.2 What's new in Window 95? 
Window 95 offers many new exciting features. Some of the features are : 

o New improved interface 

Window now features the start button and taskbar. 

Start button : It quickly opens programs, find documents, and use system 

tools. 

Task bar : It is used to switch between programs as easily as changing 

channels on T.V. 
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Windows Explorer: 

Windows Explorer is a powerful way to browse through and manage files, 

drivers and network connections. 

Long filenames: 
Windows now supports long filenames to make files easier to organise and find. 

Improved game & multimedia support: 
Faster video capability for games, enhanced support for MS-DOS based games, 

and improved performance for playing video and sound files. 

Plug and Play hardware compatability : 
User can just insert the card for Plug and play Hardware in Computer. When 

user turns on the computer window recognizes and sets up hardware automatically. 

32-bit preemptive multitasking : 
Window provides using many programs at once : do more in less time. 

Microsoft Exchange: 
It is used to view and work with all types of electronic communications, 

including e-mail and faxes. 

The Microsoft Network: 
User can use online service to communicate with people worldwide, using e- 

mail, bulletin boards and the Internet. 

4.2 Getting Started with WINDOW 95 

4.2.1 Logging  on to Windows 

In the User Name box, type your name. 

In the Password box, type a password. The first time, Windows prompts 

user to confirm his password. 

4.2_2 The Start button and taskbar 

The start button and taskbar are located at the bottom of screen when Window 

starts for the first time. By default they are always visible when Window is running. 
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Starting with the Start Menu 
When user clicks on Start button a Menu comes which contain everything that 

is needed to begin using Windows as seen in Fig.8. 

This Command Do this  

Programs Displays a list of programs to start. 

Documents Displays a list of documents opened previously. 

Settings Displays a list of system components for which 

settings can be changed. 

Find Enables to find a folder, file, shared computer, 

or mail message. 

Help Starts Help. User can use help contents, Index, or 

other tabs to find out how to do a task in Windows. 

Run Starts a program or opens a folder when user 

type an MS-DOS command. 

Shut down Shuts down or restarts computer, or logs off. 

Depending on Computer and the options user have chosen, user may see 

additional items on his menu. 

To start a Program 
Click the start button and then point to Programs. 

Point to the folder such as Accessories that contains the program, and then 

click the program. 

Opening a Document  
There are several methods to open document in Windows. Two methods are 

described below: 

A.To open document from within program: 

On the file menu, click open. 

To open a document in different folder, click the arrow next to the look in 

box, and then click the disk that contains the folder. 

(Hi) Click the folder that contains the document to be open and then click open. 

Scroll to see more folders. 

(iv) Click the document to open, and then click open. 
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B To open a_Document by using the Documents menu: 

(I) Click the start button, and then point to Documents/ 

(ii) Click tthe name of document to be open. 

Changing System Settings: 
Using Control Panel, user can change the way Window looks and works. 

Click the start button and the Point to Settings. 

Click Control panel. 

(iii)Double-click an icon to see the settings user can change. 

Finding Something on Computer: 
When the user does'nt know where a document or folder is he can use find 

command to find and open it. 

Click the start button and then point to Find. 

Click files or Folders. 
(iii)Click the Named box, and then type the name of the file or folder which is 

to be found. 
To specify where to search, click the arrow next to the look In box, or click 

Browse. 
To start the search, click Find Now. 

Getting Help: 
On line help is essential for learning and using Windows. There are two kinds 

of Help: Help about a specific procedure and Help that gives information about what 

is on the screen. 

A.To find Help through the contents: 
- Click the contents tab to find topics grouped by subject, and then follow the 

instruction on screen. 

- To return to the list of topics, click Help Topics. 

B.To find  Help through the Index: 
- Click the Index tab to find topics listed alphabetically and then follow the 

instructions on screen. 

- To return to the list of topics, click Help topics. 
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C.To find Help topics containing a word or phrase: 
- Click the Find tab to find all topics that contain a specific word or phrase, and 

then follow instructions on screen. 

D.To get Help on a specific Item: 
- For information about an item in a dialog box, click? and then click the item. 

- A pop-up explanation appears. Click it to make it disappear. 

Starting a Program by Using the Run Command; 
When the user knows the path of the program he wants to start, he can use run 

command to start it easily. 

Click the Start button and then click Run. 

Type the name of the program, folder, or document user want to open. Or 

click Browse to look for the item. 

Shutting Down Computer: 
To avoid damaging files, always shut down Windows before turning off 

Computer. 

Click the start button, and then click shut down. 

Click Yes. If the document has not been saved when Window prompts to 

save changes. 
A screen message lets user know when he can safely turn off his Computer. 

The Taskbar : 
Evertime user starts a program or open a Window, a button representing that 

window appears on the taskbar. To switch between windows, just click the button for 

the window that is required. While closing a window its button disappears from the 

task bar. 

Depending on what task user is working on, other indicators can appear in the 

notification area on the task bar, such as printer representing print job or a battery 

representing power on portable computer. At one end of the taskbar is the clock. To 

view or change settings, just double click the clock or any of the indicators. 
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4.3 Organizing Files and Folders: 

4.3.1 To move or Copy a file or folder 

Double click °My Computer, Find the file or folder user want to move or 

copy, and then click it. 

Click Edit 

- To move the file, click cut. 

- To make a copy of the file, click copy. 

Open the folder where user want to place the file, click Edit, and the click 

Paste. 

4.3.2 To delete a file or folder : 
Double-click My Computer. Find the file or folder uder want to delete, and 

then click it. 

On the File menu, click Delete. 

4.3.3 To create a new  folder: 

Double click My Computer, and then double-click the disk drive or folder in 

which user want to place the new folder. 

On the File menu, point to New, and then click Folder. 

Type the name of the new folder and then press ENTER. 

4.3.4 To copy a file to a floppy disk : 

Double-click My Computer. Find the file or folder user want to copy and 

then click it. 

On the File Menu, point to Send To, and then click the drive where user 

want to copy the file or folder. 

4.4 Printing 

4.4.1 Setting up printer for use with Windows 

- Click the start button, point to settings, and then click Printers. 

Double-click Add Printer. 

Follow instructions on Screen. 
As it is completed icon for printer appears in the Printers folder & printer 

is ready for use. 
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4.4.2 Printing a Document 
- If the document is open, click File and then click Print. 

- Double-click the printer icon in the printer folder to see the documents that 

are printing or waiting to print, and to manage printing. User can pause or 

cancel the printing of one or more documents. 

4.5 Shortcut Keys 
You can use the following keyboard shortcuts with Windows. 

To Press 

See Help on the selected dialog box item Fl 

Quit a program ALT+F4 

View the shortcut menu for the selected item SHIFT+F1 0 

Display the Start menu CTRL+ESC 

Switch to the window you last/next window ALT+TAB 

Cut CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Delete DEL 

Undo CTRL+Z 

4.5.1 For the Desktpp, My Computer, and Windows Explorer 

When an item is selected, you can use the following shortcut keys : 

To Press  

Rename an item F2 

Find a folder or file F3 

Delete immediately SHIFT + DEL 

View item properties ALT+ENTERorALT+double-click 

Copy a file CTRL key while dragging the file 

Create a shortcut CTRL+SHIFT while dragging the file 

4.5.2 For My Computer and Windows Explorer 

To Press 

Select all CTRL+A 

Refresh a window F5 

View the folder one level up BACKSPACE 
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Close the selected folder and all its parent 

folders 

Switch between left and right panes 

4.5.3 For Windows Explorer only 

To 

Go to 
Switch between left and right panes 

Expand all subfolders under the 

Expand the selected folder 

Collapse the selected folder 

Expand current selection if it's 

collapsed, otherwise selecte first subfolder 

Collapse current selection if it's 

expanded, otherwise select parent folder 

4.5.4 For Properties Dialog Boxes 

To 

Move forward through options 

Move backward through options 

Move forward through tabs 

Move backward through tabs 

4.5.5 For Open and Save As dialog boxes 

To 

Open the Save In or Look In list 

Refresh 

Open the folder one level up, 

if a folder is selected  

SHIFT while clicking the Close 

button 

F6 

Press 

CTRL+G 

F6 

NUMLOCK+ASTERISK (*) sign 

NUMLOCK+PLUS (+) sign 

NUMLOCK+MINUS(-) sign 

RIGHT Arrow 

LEFT Arrow 

Press  

TAB 

SHIFT+TAB 

CTRL+TAB 

CTRL+SHIFT+TAB 

Press 

F4 

F5 

BACKSPACE 

4.5.6 Accessibility Options shortcut keys  

To use Accessibility Options shortcut keys, the shortcut keys must be enabled. 

For more information, look up "Accessibility, shortcut keys" in the Help Index. 

To Press  

Toggle StickyKeys on and off SHIFT 5 times 

Toggle FilterKeys on and off RIGHT SHIFT for 8 seconds 
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Toggle ToiggleKeys on and off NUMLOCK for 5 seconds 

Toggle MouseKeys on and off LEFT ALT+LEFT SHIFT +NUMLOCK 

Toggle High Contrast on and off LEFT ALT+LEFT SHIFT+PRINT 
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